
Part 8 – Stairs
Introduction
Stairs symbols provided by DD3 are great but often the shape of the building isn't compatible with
them. The method described herein shows

• how to draw steps so the bevel effect can be applied to each one
• how a multipoly can affect the way a fill style is applied
• how to use transparent entities to shade the steps in regard of their respective heights
• how to handle circular or irregular stairs

About the Bevel effect
This effect only affects the edges of all the drawn area of a given sheet, similarly to the Edge Fade,
Inner effect discussed in part 7(p49-50). If all the steps of a stair are one next to the other, only the
outer edges will be beveled. The solution is to leave a small gap between steps:

Left: only the outer edges of the global rectangle are affected by the Bevel effect. Right: by creating a
small gap between the rectangles, each one is individually beveled.
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Drawing the steps
The STAIRS sheet is already included in the template:

1. Click on the Sheet Indicator and check the box left to the STAIRS sheet name. Click Hide All
then on the “H” box of WALLS TOP and FLOORS to keep them visible. If the Activate Sheet
Effects box is checked, uncheck it to speed up redraw. Click on OK to close.

2. Zoom  on the lodging.
3. From the menu toolbar invoke Tools→Snaps→Grid Settings and select the 5' Grid, 10 snap

settings.  If  it  doesn't  exist,  click  New,  select  2d Rectangular and  modify  the  settings  to
conform to the picture below.

4. Click on the Fill Style Indicator then on the Brush Pattern tab and choose the Solid fill style.
Click on . Usually, this icon is used to set the STAIRS sheet and the blue color #3. Here it
just sets the color  because the sheet was already made current at  1. The blue is used to
contrast with the rest of the map, steps will eventually have individual colors.

5. Verify that SNAP in on and use the Box  tool (BOX↵) to draw the first step.
6. Right-click Scale ,  choose Non Visual Scale XY (or just type SCALEXY↵) and select the

blue rectangle. Right-click do it (d). At the command line prompt answer 1↵ for the x-scale (or
right-click, it's the default) and 0.8↵ for the y-scale. Because the x-scale is 1, you can select
any point on the rectangle's bottom line as Scale Center, using a snapping point. 

 53 



7. Launch the Copy  tool (COP↵).  Select the blue rectangle and type d (or right-click do it).
The command line prompt reads “Copy from point”. Click the nearest possible to the lower left
corner of the rectangle, it automatically snaps to the precise point.

8. Now the prompt reads “Place (shift = Rot15°, Shift+Ctrl = Rot, Ctr = Scale)”, with the help of a
snapping point just click 1' above the point selected on step 7.

9. Repeat 8. respectively 2', 3' and 4' above the origin point. Right-click to end.

10.Use the Box  tool (BOX↵) to draw the square corner step, relying again on snapping points.
11. Right-click   and select  Mirrored Copy (MIRCPY↵).  Select the five  rectangular  steps  and

right-click do it (d).  Click the top-right corner of the square step then its bottom-left corner to
define the mirror line and create the 5 uppers steps.
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12.Right-click Change Properties  and choose Change Color  (CHANGEC↵). Select the first
step from 5. and right-click do-it (d). Type 40↵.

13.Repeat 12. for every step using the color number indicated on the picture below, right (41 to 47
and pure white 15 to finish).

Texturing the steps
The color gradient of the steps would be good on a vector map but is not really compatible with the fill
styles used for the walls and the floors. To combine both the color gradient and bitmap fill styles the
rectangles will get partially transparent and a new sheet below will receive the textured steps:

1. Create5 a new STAIRS_v fill style for the stair with a picture file of your choice or  this one,
(read the legal terms before, and convert to PNG). The “v” stands for vertical due to the wood
grain.

2. With a picture editor, clone the picture file and rotate it 90° (clockwise or counterclockwise, not
important) to create a STAIRS_h fill style (some DD3 fill style already provide horizontal and
vertical versions of the same picture file).

3. Add5 the STAIRS UNDER sheet between the WALLS and STAIRS sheets.
4. Click on the Sheet Indicator, make sure the left box of STAIRS is checked and click Hide All.
5. Right-click  and select Copy to Sheet (COPYSHT↵). Select all the steps and right-click do

it (d). Click on the STAIRS UNDER name to gray the line. Click OK.
6. Click on the Sheet Indicator again, check the left box of the STAIRS UNDER sheet, click on

Hide All then on OK to close the sheets list.

5 Refer to part 6 to get the detailed steps for creating fill styles and adding sheets.
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7. Click on the Multipoly  icon (MPOLY↵) and select all the horizontal steps and the square
one and right-click do-it (d).

8. Click on the Multipoly  icon (MPOLY↵) and select the remaining (vertical) steps and right-
click do-it (d).

9. Right-click Change Properties  and choose Change Fill Style  (CHANGEFS↵). Select the
first  multipoly  by  selecting  any of  its  steps and  right-click  do-it (d).  Type  STAIRS_h↵  or
alternatively right-click to open the Fill Style Selector and make the STAIRS_h fill style current.

10.Repeat 9. with the vertical steps multipoly and the STAIRS_v fill style.

Multipolys and fill styles
It was already mentioned (parts 2 and 5),
that Multipolys can be used when using
arcs or hollow parts in a filled shape.
When  unconnected  polygons  are
converted  in  a  single  entity  with  the
Multipoly  command, bitmap fill styles
are  applied  globally  on  the  whole  area
covered  (left  picture)  whereas  when
keeping entities individually, the fill  style
is applied from the top left corner of each
polygon, making every horizontal step a clone of the preceding (right picture).

11.  Click on the Sheet Indicator and make the FLOORS, STAIRS, GROUND, PATH, GROUND1-
3, WALLS LOW, WALLS TOP and MASK sheets visible by clicking on their “H” boxes. Select
the STAIRS sheet by clicking on its name (gray background). Check Activate Sheet Effects.
Click the right Add button and select the Transparency effect on the pop-up. Set the opacity
value on the second pop-up to 25%. Click OK.
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12.Select the STAIRS UNDER sheet (gray background). Click the right Add button and select the
Bevel effect. Set the length to 0.25, the Strength to 30, Invert Colors to 0 and Fade to 0. Click
OK to close the pop-up and OK to close the sheets list.

Adding a railing
A wooden railing can be added to the WALLS LOW sheet, using the wood textures from the stairs:

1. Click on the Sheet Indicator and check the WALLS LOW left box. Click OK to close.
2. Click on the Fill Style Indicator, on the Bitmap Files tab if necessary and on the “v” button next

to the current fill style to scroll down to STAIRS_h. Click OK to close.
3. Make sure that  SNAP is on, and that you still use the 5' Grid 10 Snap settings and use the

Polygon  tool (POLY↵) to create the horizontal part of the railing. Right-click to end.

Note: on this example the polygon was outlined
in blue to clearly show its nodes.
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4. Click on the Fill Style Indicator and select the STAIRS_v fill style. Click OK to close.
5. With the Polygon  tool (POLY↵) create the vertical parts of the railing. Right-click to end.
6. Save the map.

The stairs on the insert have been done following the method detailed herein, with the colors of the
solid, transparent, rectangles ranging from 41 (lightest) to 32 followed by 0 (black).

Other method to create stairs include 
• using the Texture effect with a bitmap file 
• creating the whole stair as a symbol
• using picture editors to create shading masks
• create dozen of fill styles from light to dark versions of a base bitmap...
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Circular stairs
To adapt the method to circular stairs you need to create the first step then use the Circular Array
tool to duplicate it. 

1. Right-click   and choose  Copy to Sheet (COPYSHT↵) to copy all walls part containing
arcs designing the staircase to the STAIRS sheet.

2. Click on the Sheet Indicator, check the left box of the STAIRS sheet, click Hide All then OK.
3. If  the arcs delimiting the stairs are included in a multipoly,  Explode  it  (EXPLODE↵).

Erase  (ERA↵) all the wall part not involved in the stairs.
4. Determine the average radius of your steps. If you have only the smaller arc, the average

radius is the small radius plus half a step's width. If you have only the outer arc, the average
radius is the longer radius minus half  a step's width. If  you already have both arcs, the
average radius is the half of the radii sum. Use  Info→List to get the radii if you have no
other mean (e.g. grid interval) to know their values.

5. Determine the angle width of a single step. The formula is 360°×
stepdepth

2×π×average radius
. In

most cases,  π can be rounded to 3 and a step depth of 1'  is  a good value too, which

simplifies the formula to: angle width =
60 °

averageradius
. For example, with an average radius

of 3' (typical of a 1' inner radius and a 5' outer radius), the angle width would be 20°. If the
inner radius is 15' and the outer one 20' the average radius is 17.5' yielding an angle width of
60÷17.5≃3.43° . The angle width must be precise only if you need a full 360° circular stair.

6. If necessary,  Draw→Offsets→ Offset One (  if you have CA46 or  OFFSET1↵) a single
staircase side by the steps width on the relevant side.

7. With the Line tool  (LINE↵) draw the edge of the raising of the lowest step. Start this line
using the grid snapping, or from the arc's center (with the Center Modifier  or F4) to any
helpful point, or by joining the corresponding endpoints (  or F5) of the arcs.

8. If necessary, use Trim to  (TRIMTO↵) to trim this line to the sides of the staircase.
9. Right-click   and choose  Rotated Copy (ROTCPY↵) to copy the line around the arc's

center (Center  or F4) by the angle width calculated at 5.
10.Draw→Offsets→ Offset One (  OFFSET1↵) the copied line 0.2' toward the original line. 
11. Split  the arcs at the endpoints (  or F5)  of the offset line and at the endpoints of the

original line if necessary. 
12.Erase  (ERA↵) the remaining parts of the arcs and the copied line from 9.
13.Multipoly  (MPOLY↵) the firs step.
14.Right-click  and choose Circular Array (CARY↵). In the example, 6 spokes, 1 ring, the

center is obtained by the  Center   or  F4  modifier  on the outer arc (even if  it's  in the
multipoly). The Copy Origin can be anywhere and the angle is the angle width of 20°. From
there proceed as shown pages 55+. See sample map page 61.
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Irregular stairs
In some cases, you might want out of the box stairs, such a winding stair around a peak or a bunch
of stairs going down between roughly hacked walls. This implies drawing each step painstakingly...

1. Right-click   and choose  Copy to Sheet (COPYSHT↵) to copy all walls part containing
entities designing the staircase to the STAIRS sheet.

2. Click on the Sheet Indicator, check the left box of the STAIRS sheet, click Hide All then OK.
3. With  the  Smooth  Path  tool  (SPLINE2↵)  draw  a  smooth  line  roughly  at  the  same

distance from both wall sides. Start at an end (in the example below: left) and overlap the
other end by a generous amount (see 4.).

4. Launch  the  Draw  →  Symbols  Along... (ESC↵)  tool,  also  called  Escarpment.  Set  the
Distance  to the depth of the steps (1' in the example), the  Symbol Angle to radial (mid
radio button),  the  Symbol to  esc line  center  and all  the  Symbol  Scale and Position
percentages to 8×stepwidth  to ensure that the lines cross the walls (see 7). For example, if
the width is about 5', set all percentages to 40%. Note that the first line is placed at the first
point of the smooth path from 3. but stops short of the other end due to rounding.

5. Since all the lines are symbols, Explode  them (EXPLODE↵). Hit p after clicking the icon
or typing the command to select all the prior entities in one go, then hit n (not) and click the
smooth path to un-select it or it will be converted in small parts. Right-click do it or hit d.

6. Erase  (ERA↵) the unwanted lines and the smooth path. 
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Irregular stairs (cont)

7. Draw→Offsets→ Offset One (  OFFSET1↵) all the steps except the first one 0.2' toward
the first. Use Ctrl+R to redraw through the command if you lost track of the offset lines.

8. Use Trim to  (TRIMTO↵) to trim all the lines to the walls. When you trim to a fractal path,
the tool gets tricky if the lines to trim do not cross the fractal (see 4.). Trim to Intersection

 (TRIMINT↵) the first and front last lines to the walls.
9. Break  (BREAK↵) the walls between the endpoints  (F5) of second and third line.
10.Save the file.
11. Right-click Explode  and choose  Line to Path (LTP2↵).  Select all the elements of the

first step and right-click do it (d).
12.Repeat 9. to 11. for each step and Erase  (ERA↵) the last line.
13.Save the file. From there proceed as shown pages 55+. See sample map below.
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Conclusion

Stairs have been added with a method that allows to benefit from a bitmap fill, a bevel effect and a
color gradient:

• A multipoly made of separate polygons fills them globally
• Leaving a small gaps between steps enables the bevel effect
• Solid colors combined with a transparency effect provide a color gradient.

The method can also be adapted to diverse shapes of staircases.

In part 9, an advanced way of creating realistic shadows on the outside will be developed.
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